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ABSTRAK: Untuk mengetahui keadaan suatu struktur baja eksisting, tingkat kelaikan maupun keamanan struktur 

dan material eksisting terhadap penerapan beban standar pada bangunan bengkel Suzuki yang berlokasi di Jalan 

Imam Bonjol No. 537 Denpasar ini dilakukan studi kelaikan struktur. Adapun data penunjang yang digunakan 

dalam studi kelaikan ini adalah as built drawing dan kuat tarik pada baja profil. Data kuat tarik pada material baja 

profil eksisting didapat dengan metode pengujian non destruktif menggunakan bantuan alat Hardness Test, lalu 

dilakukan pemodelan dan analisis struktur eksisting. Hasil dari Hardness Test menunjukkan bahwa baja profil 

memiliki kuat leleh dan kuat tarik putus sebesar 270 MPa dan 406 MPa. Data-data tersebut didapat dari hasil uji 

penelitian sebelumnya sehingga ditetapkan sebagai data sekunder dan dalam pemodelan maupun analisis struktur, 

data-data tersebut digunakan sebagai acuan. Perangkat lunak ETABS (Extended Three Dimensional Analysis of 

Building Systems) digunakan dalam analisis dan pemodelan 3-dimensi. Pemeriksaan pada baja profil dengan hasil 

output berupa desain P-M rasio yang merupakan kapasitas komponen struktur terpasang adalah hasil dari analisis. 

Secara teknis, standar kelaikan struktur dinyatakan ketika kekuatan, kekakuan, dan stabilitas terpenuhi. 

 

Kata kunci: Struktur Eksisting, Kelaikan Struktur, Struktur Baja 

 
ABSTRACT: To determine existing steel structure’s condition, the safety/suitability level of existing material and 

structure against the standard loads that will be applied to the Suzuki workshop building that located on Jalan 

Imam Bonjol No. 537 Denpasar, a structural feasibility study was carried out. The supporting data used in this 

feasibility study are as-built drawings and tensile strength of profile steel. Tensile strength data on the existing 

profile steel material was obtained using a non-destructive testing method using a Hardness Test tool, then used 

to modeling and analysis of the existing structure. The data was obained from previous research test results and 

then it was designated as secondary data, in structural modeling and analysis the data is used as a reference. The 

ETABS (Extended Three Dimensional Analysis of Building Systems) software is used in analysis and 3-dimensional 

modeling. Checkeing on the steel profile with the output result in the form of a P-M ratio design which is the 

capacity of installed structural components is the result of analysis. Technicly the feasibility standards of a 

structure are stated when strenght, stiffness and stability are met. 
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PENDAHULUAN 

Perkembangan pembangunan di pulau Bali melaju sangat pesat khususnya pada kota Denpasar. 

Hal tersebut dibuktikan dengan berkurangnya jumlah lahan kosong ataupun lahan pertanian yang kini 

sudah berubah menjadi bangunan. Dengan terbatasnya ketersediaan lahan kosong di kota Denpasar, 

masyarakat terpaksa untuk membeli atau menyewa lahan yang sudah ada dibangun untuk tempat usaha 

ataupun tempat tinggal. Sebelum membeli ataupun menyewa sebuah bangunan, perlu dipastikan 

bangunan tersebut masih layak untuk digunakan atau dioperasikan sesuai dengan fungsinya. 

Untuk menyatakan sebuah bangunan masih layak digunakan atau dioperasikan adalah 

kepemilikan SLF (Sertifikat Laik Fungsi). Kewajiban memiliki SLF (Sertifikat Laik Fungsi) bagi 

seluruh bangunan yang sudah berdiri selama kurun waktu tertentu dimuat dalam Peraturan Menteri 

PUPR RI No.27/PRT/M/2018 (Menteri PUPR RI 2018) dan Peraturan Pemerintah No.16 Tahun 2021 

(Presiden Republik Indonesia 2021). Pihak berwenang yang menerbitkan SLF adalah Pemerintah 

Daerah, sebuah bangunan tidak bisa dioperasikan secara legal jika tidak memiliki SLF. 

Salah satu bangunan yang sudah berdiri dalam kurun waktu tertentu atau bisa disebut dengan 

bangunan eksisting adalah bangunan bengkel Suzuki yang berlokasi di Jalan Imam Bonjol No. 537 

Denpasar Bali. Menurut pihak management PT. United Indobali yang menaungi bengkel Suzuki, 

diperkirakan bangunan ini sudah berumur lebih dari 29 tahun, dibangun pada tahun 1993. Karena sudah 

berdiri selama lebih dari 29 tahun, kemungkinan ada bagian struktur yang mengalami penurunan. 

Berkaitan dengan kemungkinan terjadinya penurunan pada bangunan bengkel ini, penulis 

meninjau bangunan bengkel ini untuk dilakukan studi kelaikan struktur baja eksisting. Adapun data 

penunjang yang digunakan dalam studi kelaikan ini adalah data kuat tarik baja profil yang didapat 
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dengan bantuan alat Hardness Test dan data gambar dari as built drawing. Hasil dari Hardness Test 

menunjukkan bahwa baja profil memiliki kuat leleh dan kuat tarik putus sebesar 270 MPa dan 406 MPa. Data-

data tersebut didapat dari hasil uji penelitian sebelumnya sehingga ditetapkan sebagai data sekunder dan 

dalam pemodelan maupun analisis struktur, data-data tersebut digunakan sebagai acuan. Perangkat 

lunak ETABS (Extended Three Dimensional Analysis of Building Systems) digunakan dalam analisis 

dan pemodelan 3-dimensi. Pemodelan perletakan juga dilakukan dengan asumsi bahwa sambungan pada 

pedestal cukup kaku untuk berperilaku sebagai jepit menimbang bahwa pemodelan antara menggunakan 

jepit atau sendi akan memberikan perilaku yang berbeda (Tubuh 2019). Pemeriksaan pada baja profil 

dengan hasil output berupa desain P-M rasio yang merupakan kapasitas komponen struktur terpasang 

adalah hasil dari analisis. Secara teknis, standar kelaikan struktur dinyatakan ketika kekuatan, kekakuan, 

dan stabilitas terpenuhi. 

DESAIN STRUKTUR BAJA  

Pada jaman sekarang struktur baja sudah sangat lumrah dan sangat luas digunakan sebagai salah 

satu jenis material untuk sebuah struktur, sebagai contoh pada struktur gedung-gedung bertingkat, 

struktur lepas pantai, struktur jembatan moderen dan banyak lagi struktur lain yang menggunakan baja 

sebagai material. Struktur baja dapat didefinisikan sebagai rangkaian baja batangan yang disambungkan 

dengan metode las ataupun baut, sehingga terjadi hubungan sendi pada sambungan tersebut, antara 

batangan baja profil atau rangka kaku. Hal positif dari penggunaan material baja dapat dilihat dari segi 

bobot material yang lebih ringan sehingga strukturpun juga lebih ringgan, dapat digunakan dengan  

bentang yang panjang, tingginya daktilitas yang dimiliki, dan lebih cepat dalam proses pengerjaannya 

(Liang 2015). Terlepas dari hal positif atau kelebihan tersebut, struktur baja juga memiliki beberapa 

kelemahan atau hal negatif diantaranya dari mahalnya harga jika dibandingkan dengan material lainnya 

(bersifat relatif), lemahnya ketahanan material terhadap api, dan memerlukan perawatan yang ekstra.  

DESAIN KOMPONEN STRUKTUR UNTUK TARIK 

Kelangsingan miminum yang dimiliki komponen struktur tidak dibatasi, komponen struktur yang 

dimaksud adalah komponen yang menahan gaya tarik aksial. Sedangkan pada saat mendesain komponen 

struktur bedasarkan tarik, nilai rasio kelangsingan L/r yang dimiliki tidak lebih dari 300. Nilai paling 

rendah harus diperoleh pada nilai kuat tarik desain (ɸtPn) dan kuat tarik izin (Pn⁄Ω𝑡) yang dimiliki oleh 

komponen struktur tarik sesuai dengan keruntuhan tarik penampang neto dan batas leleh tarik 

penampang bruto. 

(a) Diperuntukan pada leleh tarik yang dimiliki penampang bruto: 

𝑃𝑛 = 𝐹𝑦𝐴𝑔 (1) 

ϕt = 0,90 (DFBT)  Ω𝑡 = 1,67 (DKI) 

 

(b) Diperuntukan pada keruntuhan tarik yang dimiliki penampang neto: 

𝑃𝑛 = 𝐹𝑢𝐴𝑒 (2) 

ϕt = 0,75 (DFBT)  Ω𝑡 = 2,00 (DKI) 

Keterangan: 

Ae = simbol yang digunakan untuk menyatakan luas neto efektif, in.2 (mm2) 

Ag = simbol yang digunakan untuk menyatakan luas bruto dari komponen struktur, in.2 (mm2) 

Fy = tegangan leleh minimum terspesifikasi, ksi (MPa) 

Fu = kekuatan tarik minimum terspesifikasi, ksi (MPa) 

DESAIN KOMPONEN STRUKTUR UNTUK TEKAN 

Berikut merupakan besarnya kuat tekan desain (ϕcPn) dan kuat tekan izin (Pn⁄Ωc) pada 

komponen struktur yang memikul tekan aksial. Tertera beberapa nilai yang didasarkan pada keadaan 

batas tekuk torsi, batas tekuk lentur dan tekuk torsi-lentur yang berlaku, kemudian nilai yang harus 

diambil adalah nilai terkecil sebagai nilai kuat tekan nominal (Pn). 

ϕc = 0,90 (DFBT)  Ωc = 1,67 (DKI) 

Pada perhitungan kelangsingan komponen struktur (Lc/r), besarnya panjang efektif (Lc) 

ditentukan sesuai dengan Lampiran 7 atau Bab C pada SNI 1729:2020 (SNI 1729:2020). Berikut 
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merupakan hal yang dilakukan pada saat mendesain komponen struktur berdasarkan tekan, besarnya 

nilai rasio kelangsingan efektif (Lr/c), sebaiknya memiliki nilai yang tidak melebihi 200, sedangkan 

metode-metode selain penggunaan faktor panjang efektif (K) digunakan untuk menentukan panjang 

efektif (Lc). 

Keterangan : 

K = simbol yang digunkan untuk menyatakan faktor panjang efektif 

Lc = KL = simbol yang digunkan untuk menyatakan panjang efektif komponen struktur, in. (mm) 

L = simbol yang digunkan untuk menyatakan panjang tak terbreis lateral pada komponen struktur 

tersebut, in. (mm) 

r = simbol yang digunkan untuk menyatakan radius girasi, in. (mm) 

 Nilai kuat tekan nominal (Pn) pada komponen struktur tekan dengan elemen langsing yang 

mengalami tekan aksial harus mengambil nilai terendah. Nilai terendah yang diambil merupakan nilai 

terendah yang didapat berdasarkan keadaan batas yang berlaku berupa tekuk torsi, tekuk lentur dan 

tekuk torsi-lentur dalam interaksi terhadap tekuk lokal. 

𝑃𝑛 = 𝐹𝑐𝑟𝐴𝑒 (3) 

dengan 

Ae = nilai yang didapat dari hasil penjumlahan luas efektif penampang berdasarkan pada lebar efektif 

tereduksi, be, de atau he 

Fcr = nilai tegangan kritis, dengan Pasal E3 atau Pasal E4 SNI 1729:2020 (SNI 1729:2020) digunakan 

untuk menentukan besarnya tegangan kritis, ksi (MPa). 

DESAIN KOMPONEN STRUKTUR UNTUK LENTUR 

Keterangan di bawah diperuntukan pada lentur sederhana yang dialami suatu komponen pada 

struktur terhadap satu sumbu utama. Komponen struktur dikekang terhadap puntir pada titik-titik beban 

dan tumpuan atau yang dibebani di suatu bidang parallel terhadap sumbu utama yang melewati pusat 

geser, hal tersebut terjadi pada lentur sederhana. Berikut merupakan nilai yang harus ditentukan pada  

kuat lentur desain (ϕbMn) dan kuat lentur izin (Mn⁄Ωb): 

ϕb = 0,90 (DFBT)  Ωb = 1,67 (DKI) 

Dengan berpatokan dan disesuaikan pada Pasal F2 hingga F13 SNI 1729:2020, kekuatan lentur 

nominal (Mn) dapat ditentukan (SNI 1729:2020). Nilai pada kekuatan lentur nominal (Mn) yang 

dimiliki oleh komponen struktur profil I simetris ganda dan kanal yang melentur terhadap sumbu mayor, 

yang memiliki bandan kompak dan sayap kompak harus memperoleh nilai terendah. Nilai terendah yang 

dimaksud adalah nilai terendah pada keadaan tekuk torsi lateral dan batas leleh (momen plastis). 

1. Leleh 

𝑀𝑛 = 𝑀𝑝 = 𝐹𝑦𝑍𝑥 (4) 

dengan 

Fy = simbol yang digunakan untuk menyatakan tegangan leleh minimum yang dimiliki oleh tipe 

baja terspesifikasi yang digunakan, ksi (MPa) 

Zx = simbol yang digunakan untuk menyatakan modulus penampang plastis terhadap sumbu x, in.3 

(mm3) 

2.   Tekuk Torsi-Lateral 

(a) Keadaan batas tekuk torsi lateral tidak berlaku jika nilai Lb lebih kecil atau sama dengan nilai 

Lp. 

(b) Apabila nilai Lp lebih kecil dari nilai Lb (nilai Lb lebih kecil atau sama dengan nilai Lr) maka: 

𝑀𝑛 = 𝐶𝑏 [𝑀𝑝 − (𝑀𝑝 − 0,7𝐹𝑔𝑆𝑥) (
𝐿𝑏−𝐿𝑝

𝐿𝑟−𝐿𝑝
)] ≤ 𝑀𝑝 (5) 

(c) Apabila Lb > Lr 

𝑀𝑛 = 𝐹𝑐𝑟𝑆𝑥 ≤ 𝐿𝑟 (6) 

dengan: 
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Lb = panjang antara titik-titik, titik-titik yang dimaksud adalah baik titik yang terbreis terhadap 

puntir penampang melintang atau terbreis terhadap perpindahan lateral sayap tekan, in. (mm) 

𝐹𝑐𝑟 =
𝐶𝑏𝜋

2𝐸

(
𝐿𝑏
𝑟𝑡𝑠

))2
√1 + 0,078

𝐽𝑐

𝑆𝑥ℎ𝑜
(
𝐿𝑏

𝑟𝑡𝑠
))2  (7) 

Fcr = simbol yang digunakan untuk menyatakan tegangan kritis, ksi (MPa) 
E = simbol yang digunakan untuk menyatakan modulus elastisitas baja = 29.000 ksi (200.000 

MPa) 

J = simbol yang digunakan untuk menyatakan konstanta torsi, in.4 (mm4) 

Sx = simbol yang digunakan untuk menyatakan modulus penampang elastis terhadap sumbu x, in.3 

(mm3) 

ho = simbol yang digunakan untuk menyatakan jarak antara titik berat sayap, in. (mm) 

 

 

DESAIN KOMPONEN STRUKTUR UNTUK GESER 

Keterangan dibawah diperuntukan terhadap komponen struktur simetris tunggal maupun ganda. 

Komponen yang dimaksud pada pernyataan sebelumnya merupakan komponen yang mengalami geser 

pada arah sumbu lemah profil simetris tunggal atau ganda dan geser pada bidang badan, siku tunggal 

dan penampang PSR. Berikut merupakan nilai kekuatan geser desain (ϕvVn) dan kekuatan geser izin 

(Vn⁄Ωv) yang ditentukan: 

a) Untuk seluruh ketentuan terkecuali Pasal G2.1(a) SNI 1729:2020 (Badan Standarisasi Nasional SNI 

1729:2020 2020): 

 

ϕv = 0,90 (DFBT)  Ωv = 1,67 (DKI) 

 

(b) Dengan menyesuaikan Pasal G2 sampai Pasal G7 SNI 1729:2020, kekuatan geser nominal (Vn) 

dapat ditentukan (Badan Standarisasi Nasional SNI 1729:2020 2020). 

Berikut merupakan persamaan yang digunakan untuk menentukan kekuatan geser nominal (Vn): 

𝑉𝑛 = 0,6𝐹𝑦𝐴𝑤𝐶𝑣1 (8) 

dengan 

Fy = simbol yang digunakan untuk menyatakan tegangan leleh minimum yang dimiliki oleh tipe 

baja terspesifikasi yang digunakan, ksi (MPa) 

Aw = luas badan, yang didapat dari hasil tebal keseluruhan yang dikalikan dengan tebal badan, dtw, 

in.2 (mm2) 

DESAIN KOMPONEN STRUKTUR UNTUK KOMBINASI GAYA DAN TORSI 

Dengan cara mengikuti ketentuan pendesainan komponen struktur penahan gabungan lentur dan 

aksial tekan, dengan itu dapat dilakukannya perancangan pada elemen-elemen struktur baja. Dengan 

mengontrol perbandingan rasio aksial lentur (rasio P-M) pendesainan tersebut dapat dilakukan. Secara 

umun profil baja WF (Wide Flange) dengan simetri ganda digunakan sebagai elemen balok dan kolom 

pada struktur rangka penahan momen. Pada AISC Steel Construction Manual (American Institute of 

Steel Construction 2011) terdapat standar yang mencantumkan penamaan dan dimensi profil-profil baja 

, hal tersebut yang dijadikan sebagai acuan. Pada persamaan (9) dan persamaan (10) dibawah digunakan 

untuk mengetahui kontrol rasio P-M pada komponen struktur penahan gabungan lentur dan aksial 

bersimetri ganda. Elemen kolom merupakan elemen yang lebih cenderung sebagai komponen struktur 

penahan gabungan lentur dan aksial tekan. Persamaan (9) dan persamaan (10) dibawah dapat digunakan 

juga untuk control elemen balok, walaupun elemen balok tidak menahan aksial yang besar. 

1. Untuk  
𝑃𝑟

𝑃𝑐
≥ 0,2 

𝑃𝑟

𝑃𝑐
+

8

9
(
𝑀𝑟𝑥

𝑀𝑐𝑥
+

𝑀𝑟𝑦

𝑀𝑐𝑦
) ≤ 1,0 (9) 

2. Untuk 
𝑃𝑟

𝑃𝑐
≤ 0,2 
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𝑃𝑟

2𝑃𝑐
+

𝑀𝑟𝑐

𝑀𝑐𝑥
+

𝑀𝑟𝑦

𝑀𝑐𝑦
≤ 1,0 (10) 

Keterangan : 

𝑃𝑟 = kuat aksial perlu (𝑁) 

𝑃𝑐 = kapasitas kuat aksial (𝑁) 

𝑀𝑟 = kuat lentur perlu (𝑁. 𝑚𝑚) 

𝑀𝑐 = kapasitas kuat lentur (𝑁. 𝑚𝑚) 

𝑥 dan 𝑦 = subskrip untuk pelenturan arah sumbu kuat dan sumbu lemah 

BEBAN GRAVITASI PADA STRUKTUR 

 Beban mati dan beban hidup merupakan beban-beban yang menyusun beban gravitasi pada 

struktur. Beban mati didefinisikan sebagai beban yang timbul ataupun ada berkat semua material yang 

digunakan pada sebuah struktur bangunan. Sedangkan beban hidup didefinisikan sebagai beban yang 

tercipta akibat penggunaan atau penghunian suatu gedung dan juga beban-beban yang diakumulasian 

dari semua barang yang terletak di dalam gedung dan dapat dipindah-pindahkan. 

 

BEBAN LATERAL PADA STRUKTUR 

 Beban lateral merupakan beban yang memiliki arah horizontal, yang termasuk beban dengan 

arah horizontal adalah beban gempa dan beban angin. Beban gempa didefinisikan sebagai pergerakan 

tanah yang disebabkan oleh getaran pada saat gempa bumi sehingga menjadi beban yang dialami oleh 

struktur. Langkah-langkah yang perlu diperhatikan dalam analisis gempa (SNI 1726:2019): 

1. Menentukan kategori resiko bangunan 

2. Menentukan kategori desain seismic 

3. Menentukan system penahan gempa 

4. Menentukan perioda fundamental pendekatan 

5. Menentukan koefisien respon seismik 

6. Gaya geser seismik 

7. Penentuan simpangan antar lantai 

Beban angin adalah yang diakibatkan oleh terpaan angin yang mengenai struktur yang berada 

pada lintasan angin, sehingga aliran angin yang menerpa struktur dapat berbelok bahkan hingga terhenti. 

Beban angin ditentukan dengan langkah-langkah berikut (SNI 1727:2020): 

1. Tentukan kategori resiko bangunan 

2. Tentukan kecepatan angina dasar sesuai kategori resiko 

3. Tentukan parameter beban angin 

4. Tentukan koefisien eksposur tekanan velositas 

5. Tentukan koefisien tekanan eksternal 

6. Hitung tekanan angin 

 

KOMBINASI PEMBEBANAN 

Pada SNI 1727:2020, terdapat tiga kondisi pada kombinasi pembebananan diantaranya; 

kombinasi beban nominal yang menggunakan desain tegangan izin; kombinasi beban terfaktor yang 

digunakan dalam metode desain kekuatan; dan kombinasi beban untuk kejadian luar biasa. Pada 

perancangan struktur beton bertulang menggunakan kombinasi metode desain kekuatan yakni sebagai 

berikut (SNI 1727:2020): 

1. 1,4D 

2. 1,2D + 1,6L + 0,5(Lr atau R) 

3. 1,2D + 1,6(Lr atau R) + (L atau 0,5W) 

4. 1,2D +1,0W +L + 0,5(Lr atau R) 

5. 0,9D +1,0W 

Keterangan: 

𝐷 : beban mati 

𝐿 : beban hidup 

𝐿𝑟 : beban hidup atap 
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𝑊 : beban angin 

𝑅 : beban hujan 

𝐻 : beban tekanan tanah 

𝐹 : beban fluida 

Catatan: 

1. Berikut merupakan kombinasi yang perlu ataupun harus diperhitungkan juga pada kombinasi dasar 

apabila struktur mengalami efek beban seismic: 

6. 1,2D + Ev + Emh + L 

(1,2 + 0,2SDS) D + Ω0𝒬𝐸 + L 

7. 0,9D - Ev + Emh 

(0,9 - 0,2SDS) D + Ω0𝒬𝐸 

Keterangan: 

SDS : Parameter percepatan spektrum respon desain 

Ω0  : faktor kuat lebih 

𝒬𝐸 : pengaruh beban seismik horizontal dari V, Fpx, atau Fp 

 

2. Faktor beban yang sama harus disertakan pada kombinasi seperti contoh beban mati (D) yang 

terdapat pada kombinsi (1) sampai dengan kombinasi (4), hal tersebut dilakukan apabila terdapat 

beban fluida (F). 

3. Berikut merupakan kombinasi yang harus diperhitungkan apabila terdapat beban H : 

1) Bila efek beban utama bertambah akibat efek beban H, maka H dihitung dengan faktor beban 

sebesar 1,6 

2) Bila efek beban utama bertambah akibat efek beban H, maka H dihitung dengan faktor beban 

sebesar 0,9 hal tersebut dilakukan jika beban adalah permanen atau faktor beban sebesar 0 untuk 

kondisi lainnya 

Sedangkan pada perancangan pondasi bangunan menggunakan kombinasi metode desain tegangan izin 

sebagai berikut: 

1. D 

2. D + L 

3. D + (Lr atau R) 

4. D + 0,75L + 0,75(Lr atau R) 

5. D + 0,6W 

6.  D + 0,75L + 0,75 (0,6W) + 0,75(Lr atau R) 

7. 0,6D + 0,6W 

Catatan: 

1. Faktor beban yang sama harus disertakan pada kombinasi seperti contoh beban mati (D) pada 

kombinsi (1) sampai kombinasi (6), hal tersebut dilakukan apabila terdapat beban fluida (F). 

2. Berikut merupakan kombinasi yang harus diperhitungkan apabila terdapat beban H : 

1) Bila efek beban utama bertambah akibat efek beban H, maka H dihitung dengan faktor beban 

sebesar 1,0 

2) Bila efek beban utama bertambah akibat efek beban H, maka H dihitung dengan faktor beban 

sebesar 0,6 hal tersebut dilakukan jika beban adalah permanen atau faktor beban sebesar 0 untuk 

kondisi lainnya 

METODE PENELITIAN 

Perangkat lunak (software) ETABS (Extended Three Dimensional Analysis of Building System) 

digunakan untuk pemodelan struktur pada studi kelaikan ini. Adapun langkah-langkah penggunaan 

program ETABS sebagai berikut : 

1. Membuat grid model struktur, sesuaikan dengan as built drawing. 

2. Setelah grid model selesai dibuat tahap selanjutnya adalah mendefinisikan material struktur 

dengan cara Define → Material Properties. 

3. Mendefinisikan elemen struktur dengan cara Define→Section Property→Frame Section 

kemudian klik add new property 

4. Kemudian menginput beban-beban yang bekerja pada struktur dengan cara klik Define →Load 

Patterns. Lalu tentukan jenis beban yang bekerja dengan mengisi kolom Load Petterns Name → 
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Type →Self Weight Multiplier →Auto Lateral Load Pattern → Add New Load Petern →  Klik 

OK. Maka muncul tampilan menu di bawah ini 

 

Gambar 1. Tampilan Menu Define Load Pattern Setelah Input Beban 

5. Menginput kombinasi pembebanan dengan cara klik Define→Load Combination kemudian pilih 

Add New Combo. Masukan kombinasi beban sesuai yang tertera pada SNI 1727:2020 

Gambar 2. Tampilan Menu Load Combination 

 

Gambar 3. Tampilan Menu Load Combination Data 

6. Setelah data geometri, property elemen dan beban-beban diberikan, maka struktur sudah dapat 

dianalisis. Pastikan beban apa saja yang akan dipakai sebelum melakukan analisis (Run) dengan 

cara klik Analyze→Set Load Case To Run. Setelah memastikan beban yang dipakai, pilih menu 

Run Now. 
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Gambar 4. Tampilan Menu Set Load Case To Run 

Setelah melakukan Run Analyze selanjutnya dilakukan pengecekan P-M Rasio pada baja profil dengan 

langkah-langkah sebagai berikut: 

1. Memastikan peraturan yang akan digunakan dengan memilih menu Design→Steel Frame 

Design→View/Revise Preferences. Maka terlihat tampilan seperti di bawah 

Gambar 5. Tampilan Menu Steel Frame Design Preferences 

2. Pilih kombinasi beban yang akan digunakan. Pilih menu Design→Steel Frame Design→Select 

Design Combination 

Gambar 6. Tampilan Menu Design Load Combination Selection 
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3. Pilih semua balok dengan cara pilih menu Select → Select → Properties → Frame Section 

4. Pilih material balok yang di gunakan pada struktur. Untuk memodifikasi kekangan lateral pada 

balok pilih menu Design → Steel Frame Design → Lateral Bracing. Maka akan menampilkan 

jendela di bawah 

Gambar 7. Tampilan Menu Lateral Bracing 

5. Pilih tab Specify Uniform Bracing untuk menyatakan bahwa kekangan berasal dari pelat beton 

yang barawal dari ujung awal sampai ujung akhir. Pilih Brace Type bagian Top 

 

Gambar 8. Tampilan Menu Uniform Braces 

6. Saat ini model struktur sudah siap dilakukan tahap desain. Pilih menu Design → Steel Frame 

Design →  Start Design/Check. Tunggu beberapa saat hingga ETABS selesai menjalankan 

proses desain. 

7. Untuk menampilkan P-M Ratio lakukan dengan cara pilih menu Design →  Steel Frame Design 

→ Display Design Info 

Gambar 9. Tampilan Menu Design Output 
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8. Pastikan tampilan denah, setelah itu akan muncul nilai P-M ratio pada baja profil 

Gambar 10. Tampilan P-M Ratio pada Balok 

Gambar 11. Tampilan P-M Ratio pada Kolom 

HASIL DAN PEMBAHASAN 

HASIL PEMODELAN STRUKTUR BAJA EKSISTING 

Pemodelan ini dilakukan dengan bantuan program ETABS (Extended Three Dimensional Analysis 

of Building System), adapun hasil pemodelan struktur baja eksisting  sebagai berikut: 

Gambar 12. Model Struktur 3D Bangunan Bengkel Suzuki 

 

 

 

 



I Made Sastra Wibawa, I Ketut Diartama Kubon Tubuh, I Made Andi Kusuma Wijaya 

70          Jurnal Ilmiah Kurva Teknik, Vol. 13, No. 1, Mei 2024 

HASIL DESAIN 

Tabel 1. Hasil Desain Struktur Bengkel 

Penampang 

Struktur 

PMM 

Ratio 
P Ratio 

M 

Major 

Ratio 

M 

Minor 

Ratio 

V 

Major 

Ratio 

V 

Minor 

Ratio 

K5 

(30x45 + WF350) 
0,24 0,021 0,116 0,128 0,05 0,011 

K7 

(WF350x175x7x11) 
0,985 0,239 0,461 0,546 0,293 0.059 

K9  

(King Cross) 

(350x175x7x11) 

0,661 0,076 0,306 0,456 0,051 0,165 

B4 

(WF350x175x7x11) 
0,693 0,091 0,679 0,022 0,443 0,001 

B5 

(WF 250x125x6x9) 
1,215 0,072 1,124 0,004 0,225 0 

RB5 

(WF 150x75x5x7) 
2,602 0,641 2,556 0,033 0,03 0,003 

GD 

(CNP 125x65x6x8) 
0,95 0,044 0,764 0,529 0,098 0,046 

Dari data pada table di atas, ditemukan penampang struktur baja yang menerima gaya lebih besar 

dari kapasitas yang dimiliki. Diantaranya pada balok B5 memiliki rasio interaksi gaya aksial dan lentur 

sebesar 1,215 dan rasio lentur pada sumbu kuat sebesar 1,124; Dan pada balok RB5 memiliki rasio 

interaksi gaya aksial dan lentur sebesar 2,602 dan rasio lentur pada sumbu kuat sebesar 2,556. Dari 

penampang struktur baja yang disebutkan sebelumnya, penampang struktur baja tersebut menerima gaya 

lebih besar dari kapasitas yang dimiliki ( melewati batas Ref = 1,0). Dengan kata lain struktur tersebut 

memerlukan perkuatan. 

Setelah diketahui struktur yang memerlukan perkuatan, selanjutnya dilakukan percobaan dengan 

menambahkan baja profil pada sisi lemah struktur baja sehingga dimensi struktur berubah menjadi lebih 

besar dari sebelumnya. Sebagai contoh pada struktur baja B5 (WF 250x125x6x9 mm) ditambahkan baja 

profil T 125x125x6x9 mm sedemikian rupa pada sisi lemahnya sehingga penampang struktur 

mengalami perubahan dimensi dan menunjukan rasio yang memenuhi syarat. Penambahan baja profil 

juga dilakukan pada penampang struktur RB5 (WF 150x75x5x7 mm), ditambahkan dengan baja profil 

T 75x75x5x7 mm. Hasil desain penambahan baja profil pada balok B5 bisa dilihat pada Gambar 13 dan 

balok RB5 bisa dilahat pada Gambar 14, selanjutnya perubahan rasio bisa dilihat pada Tabel 2. 
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Gambar 13. Perkuatan pada B5    Gambar 14. Perkuatan pada RB5 

 

 

 

 

Tabel 2. Hasil Desain Struktur Setelah Diperkuat Pada Balok B5 dan RB5 

 Penampang 

Struktur 

PMM 

Ratio 
P Ratio 

M 

Major 

Ratio 

M 

Minor 

Ratio 

V 

Major 

Ratio 

V 

Minor 

Ratio 

K5 

(30x45 + WF350) 
0,24 0,021 0,116 0,128 0,05 0,011 

K7 

(WF350x175x7x11) 
0,955 0,238 0,464 0,54 0,293 0.059 

K9  

(King Cros ) 

(350x175x7x11) 

0,663 0,077 0,308 0,458 0,051 0,164 

B4 

(WF350x175x7x11) 
0,694 0,091 0,688 0,022 0,443 0,001 

B5 

(WF 250x125x6x9) 
0,825 0,072 0,823 0,004 0,23 0 

RB5 

(WF 150x75x5x7) 
0,569 0,417 0,319 0,087 0,026 0,002 

GD 

(CNP 125x65x6x8) 
0,94 0,043 0,764 0,529 0,098 0,046 

Tambahan dimensi baja 

profil T 125x125x6x9 mm 

Tambahan dimensi baja 

profil T 75x75x5x7 mm 
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KESIMPULAN 

Berdasarkan hasil penelitian simpulan yang didapat, adalah sebagai berikut: 

a. Pada bangunan-bangunan gedung dengan struktur baja yang dibangun pada tahun yang sama dengan 

bangunan bengkel Suzuki yaitu tahun 1993 yang masih berdiri hingga saat ini maupun yang 

direncanakan akan tetap dioperasikan sampai beberapa waktu kedepan, sangat perlu dilakukannya 

analisa kelaikan struktur. Hal tersebut dilakukan agar diketahui apakah bangunan gedung masih 

aman maupun layak untuk dioperasikan, jika tidak layak maka diketahui struktur mana saja yang 

memerlukan perkuatan. 

b. Pada elemen struktur baja bangunan bengkel kapasitas yang dimiliki lebih kecil dari pada gaya yang 

diterima, diantaranya adalah : 

- Balok B5 memiliki rasio interaksi gaya aksial dan lentur sebesar 1,215 dan rasio lentur pada 

sumbu kuat sebesar 1,124 

- Balok RB5 memiliki rasio interaksi gaya aksial dan lentur sebesar 2,602 dan rasio lentur pada 

sumbu kuat sebesar 2,556 

Karena kapasitas yang dimiliki lebih kecil dari pada gaya yang diterima, maka penampang struktur baja 

B5 dan RB 5 memerlukan perkuatan 

c. Salah satu metode perkuatan yang dapat diterapkan pada struktur baja eksisting adalah dengan 

penambahan baja profil. Metode ini dilakukan dengan cara menambahkan suatu baja profil 

sedemikian rupa pada bagian lemah struktur terpasang, sehingga terjadi perkuatan pada bagian 

lemah dan dimensi penampang struktur berubah menjadi lebih besar. Sebagai contoh suatu kolom 

struktur baja profil WF350 x 175 memiliki rasio kapasitas pada sumbu lemahnya melewati ref (1,0). 

Perkuatan yang bisa disarankan berupa penambahan baja profil T 175 dengan cara dilas pada sisi 

lemah kolom, sehingga dimensi kolom berubah menjadi Qween Cross WF 350. 

 

Gambar 13. Contoh perkuatan dengan penambahan baja profil 
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